
 
 

44 
Sifa Kamelia, 2023 
Pengaruh Model Pembelajaran Advance Organizer terhadap Hasil Belajar Siswa 
Universitas Pendidikan Indonesia I repository.upi.edu I perpustakaan.upi.edu 

BAB III 

OBJEK DAN DESAIN PENELITIAN 

3.1 Subjek dan Objek Penelitian 

Subjek penelitian ini adalah siswa Kelas XII program keahlian Otomatisasi dan Tata 

Kelola Perkantoran di SMK Pasundan 1 Cimahi. Objek penelitian terdiri dari dua variabel, 

yaitu model pembelajaran Advance Organizer (X) sebagai variabel independen dan hasil 

belajar siswa (Y) sebagai variabel dependen. Siswa kelas XII OTKP di SMK Pasudan 1 Cimahi 

menjadi responden dalam penelitian ini. 

3.2 Desain Penelitian 

3.2.1 Metode Penelitian 

Jenis penelitian yang digunakan pada penelitian ini adalah kuantitatif dengan 

menggunakan metode eksperimen. Metode eksperimen merupakan penelitian yang diberi 

perlakuan tertentu terhadap yang lain serta berguna untuk mencari pengaruh di dalam kondisi 

yang terkendalikan (Sugiyono, 2015, hlm. 72). 

“Melalui metode penelitian seperti inilah peneliti dapat memperoleh data yang 

meyakinkan mengenai efek dari suatu variabel pada variabel yang lain” (Hikmawati, 2020, 

hlm. 136). Dalam hal ini, variabel yang dimaksud adalah model pembelajaran Advance 

Organizer dan hasil belajar siswa.  

Pada penelitian ini, penulis akan melakukan metode kuasi eksperimen. Kuasi 

eksperimen digunakan ketika pada situasi nyata sulit mendapatkan kelompok kontrol yang 

digunakan untuk penelitian (Sugiyono, 2015, hlm. 77).  

3.2.2 Desain Penelitian  

Desain penelitian yang digunakan dalam penelitian ini adalah One Group Pretest 

Posttest Design karena hanya melibatkan satu kelompok kontrol tanpa adanya kelompok 

pembanding karena adanya keterbatasan dalam penelitian, namun memberikan gambaran yang 

lebih akurat mengenai efek perlakuan karena membandingkan kondisi sebelum dan setelah 

perlakuan. Penelitian ini dapat dikendalikan menggunakan cara lain dengan tujuan untuk 

menyelidiki hubungan sebab-akibat tanpa adanya kelompok kontrol (Sahir, 2021, hlm. 7). 

Desain ini merupakan turunan dari bentuk desain eksperimen Pre-Experimental (Sugiyono, 

2015, hlm. 74).  

Penelitian ini menggunakan desain dengan memberikan pretest terlebih dahulu 

sebelum memberikan perlakuan, dan kemudian diikuti dengan posttest setelah perlakuan 
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diberikan. Dalam konteks ini, siswa kelas XII OTKP akan diuji dengan pretest yang berkaitan 

dengan materi pembelajaran Otomatisasi Tata Kelola Keuangan, lalu diberikan perlakuan 

menggunakan model pembelajaran Advance Organizer sebelum diuji kembali dengan posttest. 

Tujuan dari desain ini adalah untuk menilai sejauh mana pengaruh penggunaan model 

pembelajaran Advance Organizer terhadap hasil belajar siswa dalam mata pelajaran 

Otomatisasi Tata Kelola Keuangan.. 

Penelitian ini merupakan eksperimen dengan penerapan pembelajaran menggunakan 

model pembelajaran Advance Organizer di dalam kelas. Penelitian ini dilakukan dalam tiga 

pertemuan di kelas. Metode penelitian ini mengikuti paradigma kuasi-eksperimen dengan 

desain one group pretest posttest. 

 

 

 

 

Gambar 3.1 

Paradigma Penelitian One Group Pretest Posttest Design 

Keterangan: 

O1  : nilai pretest (sebelum diberikan perlakuan) 

X  : perlakuan yang diberikan (model pembelajaran Advance Organizer) 

O2  : nilai posttest (setelah diberikan perlakuan) 

O2 −  O1  : pengaruh model pembelajaran Advance Organizer terhadap hasil belajar 

3.2.3 Populasi dan Sampel Penelitian 

“Populasi adalah wilayah generalisasi yang terdiri atas: obyek/subyek yang mempunyai 

kualitas dan karakteristik tertentu yang ditetapkan oleh peneliti untuk dipelajari dan kemudian 

ditarik kesimpulannya” (Sugiyono, 2015, hlm. 80). Populasi merupakan semua subjek yang 

diteliti dan sampel merupakan sepenggal dari populasi yang akan diteliti (Sahir, 2021, hlm. 

34).  

Sampel yang diteliti harus mencerminkan situasi dari populasi, maksudnya kesimpulan 

atas populasi merupakan hasil penelitian yang harus didasari kesimpulan hasil sampel (Hardani 

et al., 2020, hlm. 362). 

Berdasarkan pernyataan sebelumnya, populasi dalam penelitian ini terdiri dari siswa 

kelas XII program keahlian Otomatisasi dan Tata Kelola Perkantoran (OTKP) di SMK 

Pasundan 1 Cimahi, yang sedang mengikuti mata pelajaran Otomatisasi Tata Kelola Keuangan 

O1     X      O2 
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dengan materi Kas Kecil dalam Perusahaan pada tahun ajaran 2023/2024. Sampelnya akan 

menggunakan teknik sampling jenuh (tuntas) karena menggunakan seluruh populasinya 

(Hardani et al., 2020, hlm. 369). Sampel penelitian ini terdiri dari 33 siswa kelas XII program 

keahlian Otomatisasi dan Tata Kelola Perkantoran (OTKP) di SMK Pasundan 1 Cimahi, yang 

diobservasi sebelum dan sesudah diberikan perlakuan. 

3.2.4 Teknik dan Alat Pengumpulan Data 

Kualitas data penelitian berkaitan dengan akurasi metode yang digunakan untuk 

mengumpulkan data (Sugiyono, 2015, hlm. 137). Dalam penelitian ini, penulis menggunakan 

berbagai teknik pengumpulan data sebagai berikut: 

1. Observasi 

Observasi merupakan metode yang digunakan untuk mengumpulkan informasi terkait 

objek penelitian yang akan diteliti. Dalam penelitian ini, data yang relevan adalah 

mengenai proses belajar mengajar yang terjadi di dalam kelas. Data tersebut akan 

dinilai melalui lembar observasi. Penggunaan metode observasi ini diharapkan dapat 

memberikan data yang lebih komprehensif, akurat, dan mendalam dalam memahami 

setiap perilaku yang terjadi di dalam kelas (Sugiyono, 2015, hlm. 145). 

2. Tes 

Penulis akan melakukan dua jenis tes, yaitu pre-test dan posttest kepada siswa kelas 

XII program keahlian Otomatisasi dan Tata Kelola Perkantoran (OTKP) di SMK 

Pasundan 1 Cimahi. Tes ini bertujuan untuk mengukur kemampuan siswa sebelum dan 

setelah diberi perlakuan pembelajaran. Hasil belajar siswa akan dinilai melalui soal-

soal yang mengacu pada Rencana Pelaksanaan Pembelajaran (RPP) pada Kompetensi 

Dasar (KD) 3.10 dan 4.10, dengan materi yang terkait mengenai Kas Kecil dalam 

Perusahaan. 

3. Dokumentasi 

Dokumentasi yang akan dilakukan penulis akan menjadi penunjang bukti perlakuan 

pada objek penelitian. Data yang diperoleh dari dokumentasi ini diantaranya adalah foto 

selama kelas berlangsung, daftar nama siswa, dan data nilai yang digunakan sebagai 

acuan hasil belajar.  

3.2.5 Pengujian Instrumen Penelitian 

Pengujian instrumen penelitian dilakukan untuk memastikan keakuratan dan keandalan 

instrumen yang telah dibuat dalam penelitian. Pengujian instrumen mencakup dua aspek, yaitu 

validitas dan reabilitas. Maksud dari pengujian tersebut yaitu “… validitas dan reabilitas 
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merupakan tempat kedudukan untuk menilai kualitas semua alat dan prosedur pengukuran” 

(Abdurahman et al., 2011, hlm. 49). 

3.2.5.1 Uji Validitas 

Uji validitas yang digunakan menggunakan formula koefisien korelasi product moment 

dari Karl Pearson (Abdurahman et al., 2011, hlm. 50), yaitu sebagai berikut: 

𝑟𝑥𝑦 =
𝑁 ∑ 𝑋𝑌 − ∑ 𝑋. ∑ 𝑌

√[𝑁 ∑ 𝑋2 −  (∑ 𝑋)2] [𝑁 ∑ 𝑌2 −  (∑ 𝑌)2]
 

Keterangan: 

rxy = koefisien korelasi antara variabel X dan Y 

N = jumlah subjek pengikut tes 

X = skor butir soal yang dicari validitasnya 

Y = skor total 

XY = perkalian antara skor butir soal dengan skor total 

Kriterianya adalah jika nilai hitung r > dari nilai tabel r  (α) = 5% maka item instrumen 

dinyatakan valid. 

Data uji validitas dapat diolah menggunakan IBM SPSS Statistic 26 yang langkah-

langkahnya dilakukan sebagai berikut: 

1. Buka aplikasi IBM SPSS Statistic 26. 

2. Pada Data View, masukkan semua butir soal dan total skor benar yang didapatkan 

oleh siswa. Kode untuk jawaban yang benar adalah 1, sedangkan 0 adalah kode 

untuk jawaban yang salah. 

3. Klik Analyze -> Correlate -> Bivariate. 

4. Jendela Bivariate Correlations terbuka. Masukkan seluruh butir soal dan total ke 

dalam Variables. 

5. Pilihan Correlation Coefficients-nya adalah Pearson dengan Test of Significance-

nya adalah Two-tailed. Pastikan Flag significant correlationsnya sudah tercentang. 

6. Klik OK. 

Berdasarkan uji instrumen tes yang telah dilakukan di dua sekolah, yaitu SMK 

Kiansantang dan SMK Insan Mandiri, dengan total siswa sebanyak 53 orang, didapatkan data 

hasil uji validitas sebagai berikut: 
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Tabel 3.1 

Hasil Uji Validitas Instumen Tes 

Nomor Item rhitung rtabel Kesimpulan 

1 0,675 0,270 Valid 

2 0,395 0,270 Valid 

3 0,590 0,270 Valid 

4 0,357 0,270 Valid 

5 0,707 0,270 Valid 

6 0,315 0,270 Valid 

7 0,680 0,270 Valid 

8 0,455 0,270 Valid 

9 0,662 0,270 Valid 

10 0,591 0,270 Valid 

11 0,357 0,270 Valid 

12 0,694 0,270 Valid 

13 0,383 0,270 Valid 

14 0,384 0,270 Valid 

15 0,657 0,270 Valid 

16 0,590 0,270 Valid 

17 0,724 0,270 Valid 

18 0,719 0,270 Valid 

19 0,533 0,270 Valid 

20 0,724 0,270 Valid 

21 0,603 0,270 Valid 

22 0,526 0,270 Valid 

23 0,737 0,270 Valid 

24 0,619 0,270 Valid 

25 0,625 0,270 Valid 

Sumber: Hasil pengolahan data IBM SPSS Statistic 26 

Hasil uji validitas menunjukkan bahwa semua nomor item dalam penelitian ini valid. 

Semua siswa dari dua sekolah, yaitu SMK Kiansantang dan SMK Insan Mandiri, memberikan 

tanggapan yang konsisten. Ini berarti data yang diperoleh dapat diandalkan dan relevan untuk 

diterapkan pada pretest dan posttest. 

3.2.5.2 Uji Reliabilitas 

Uji reliabilitas menggunakan formula Koefisien Alfa (α) dari Cronbach (1951) 

(Arikunto dalam Abdurahman et al., 2011, hlm. 56), yaitu sebagai berikut: 

𝑟11 =  [
𝑘

𝑘 − 1
] . [1 −  

∑ 𝜎𝑖
2

𝜎𝑖
2 ] 
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Dimana: 

Rumus varians = 𝜎2 =  
∑ 𝑥2− 

(∑ 𝑥)2

𝑁

𝑁
 

Keterangan: 

r11  = reliabilitas instrumen atau koefisien korelasi atau korelasi alpha 

k  = banyaknya bulir soal 

∑ 𝜎𝑖
2  = jumlah varians bulir 

𝜎𝑖
2  = varians total 

𝑁  = jumlah responden 

Data uji reliabilitas dapat diolah menggunakan IBM SPSS Statistic 26 yang langkah-

langkahnya dilakukan sebagai berikut: 

1. Buka aplikasi IBM SPSS Statistic 26. 

2. Pada Data View, masukkan semua butir soal dan total skor benar yang didapatkan 

oleh siswa. Kode untuk jawaban yang benar adalah 1, sedangkan 0 adalah kode 

untuk jawaban yang salah. 

3. Klik Analyze -> Scale -> Reliability Analysis. 

4. Jendela Reliabilty Analysis terbuka. Masukkan seluruh butir soal (kecuali skor 

total dan jika ada butir soal yang tidak valid) ke dalam Items. 

5. Klik OK. 

Kriterianya adalah jika nilai hitung r > dari nilai tabel r  (α) = 5% maka item instrumen 

dinyatakan reliabel dan layak dipergunakan sebagai alat pengumpulan data. Kriteria rentangan 

nilai koefisien alphanya adalah sebagai berikut: 

 

Tabel 3.2 

Kriteria Reliabilitas 

Rentangan Nilai r11 Kriteria Reliabilitas 

0 Tidak memiliki reabilitas (no reliability) 

>.070 Reliabilitas dapat diterima (acceptable reliability) 

>.80 Reliabilitas yang baik (good reability) 

>.90 Reliabilitas yang sangat baik (excellent reability) 

1 Reliabilitas sempurna (perfect reability) 

Sumber: (Budiastuti & Bandur, 2018, hlm. 211) 
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Berdasarkan uji instrumen tes yang telah dilakukan di dua sekolah, yaitu SMK 

Kiansantang dan SMK Insan Mandiri, dengan total siswa sebanyak 53 orang, didapatkan data 

hasil uji relialibilitas sebagai berikut: 

Tabel 3.3 

Hasil Uji Reliabilitas Instrumen Tes 

Nomor 
Hasil 

Kesimpulan 
rhitung rtabel 

1. 0,915 0,270 Reliabilitas yang sangat baik 

Sumber: Hasil pengolahan data IBM SPSS Statistic 26 

Hasil uji reliabilitas menunjukkan bahwa alat yang digunakan dalam penelitian ini 

dapat diandalkan. Hal ini berarti instrumen tersebut memberikan hasil yang konsisten dan stabil 

dalam mengukur variabel yang diteliti. Maka kesimpulan dari uji reliabilitas ini adalah 

reliabilitas instrumen yang sangat baik. 

3.2.5.3 Uji Taraf Kesukaran 

Indeks kesukaran (difficulty index) adalah nominal yang memperlihatkan sulit atau 

mudahnya suatu soal. Rentang indeks kesukarannya berada diantara 0,00 – 1,0. Soal yang sukar 

berada di rentang 0,0 sebaliknya jika soalnya mudah maka rentangnya berada di indeks 1,0. 

Berikut klasifikasinya: 

Tabel 3.4 

Klasifikasi Indeks Kesukaran Soal 

Indeks Kesukaran Klasifikasi Indeks Kesukaran 

0,00 – 0,30 Sukar 

0,30 – 0,70 Sedang 

0,70 – 1,00 Mudah 

Sumber: Komarudin, 2017, hlm. 171 

Soal yang dibuat lebih baik tidak terlalu sulit dan tidak terlalu mudah. Jika soal terlalu mudah, 

maka siswa tidak terangsang untuk memecahkan soal tersebut. Jika soal terlalu sulit, maka 

siswa akan kehilangan motivasi dalam memecahkannya karena diluar jangkauannya. Berikut 

rumus dalam mencari indeks kesukaran menurut Komarudin (2017, hlm. 168-169) : 

P =  
B

JS
 

Keterangan: 

P = indeks kesukaran 

B = banyak siswa yang menjawab soal dengan benar 
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JS = jumlah seluruh siswa peserta tes 

Data uji taraf kesukaran dapat diolah menggunakan IBM SPSS Statistic 26 yang 

langkah-langkahnya dilakukan sebagai berikut: 

1. Buka aplikasi IBM SPSS Statistic 26. 

2. Pada Data View, masukkan semua butir soal dan total skor benar yang didapatkan oleh 

siswa. Kode untuk jawaban yang benar adalah 1, sedangkan 0 adalah kode untuk 

jawaban yang salah. 

3. Klik Analyze -> Descriptive Statistics -> Frequencies. 

4. Jendela Frequencies terbuka. Masukkan seluruh butir soal (kecuali skor total dan jika 

ada soal yang tidak valid) ke dalam Variables-> Klik Statistics. 

5. Jendela Statistics terbuka. Pada Central Tendency, centang Mean -> Continue. 

6. Klik OK. 

Berdasarkan uji instrumen tes yang telah dilakukan di dua sekolah, yaitu SMK 

Kiansantang dan SMK Insan Mandiri, dengan total responden sebanyak 53 orang, didapatkan 

data hasil uji taraf kesukaran sebagai berikut: 

Tabel 3.5 

Hasil Uji Instrumen Taraf Kesukaran 

No. Klasifikasi Nomor Soal Jumlah 

1. Sukar  0 

2. Sedang 

1, 2, 3, 4, 5, 7, 8, 9, 

10, 11, 12, 14, 15, 

16, 17, 18, 19, 20, 

21, 22, 23, 24, 25 

23 

3. Mudah 6, 13 2 

Sumber: Hasil pengolahan data IBM SPSS Statistic 26 

Berdasarkan hasil klasifikasi tingkat kesukaran soal, uji instrumen ini menunjukkan 

bahwa mayoritas soal berada pada tingkat kesukaran "Sedang" dengan 23 nomor soal. Soal-

soal dengan tingkat kesukaran "Sedang" ini mencakup nomor soal 1, 2, 3, 4, 5, 7, 8, 9, 10, 11, 

12, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, dan 25. Selain itu, terdapat juga dua nomor soal 

yang tergolong sebagai soal "Mudah", yaitu nomor soal 6 dan 13. 

Hasil ini memberikan gambaran mengenai distribusi tingkat kesukaran soal dalam 

penelitian. Tingkat kesukaran soal yang dominan berada pada kategori "Sedang" menunjukkan 

bahwa soal-soal tersebut memiliki tingkat kesulitan yang seimbang dan dapat dihadapi oleh 
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siswa. Sementara itu, adanya beberapa soal yang tergolong "Mudah" memberikan variasi pada 

tingkat kesukaran dan memungkinkan adanya soal-soal yang lebih mudah dijawab oleh siswa. 

3.2.5.4 Uji Daya Beda 

Daya pembeda soal adalah kemampuan suatu soal dalam membedakan siswa yang 

memiliki kemampuan tinggi dengan siswa yang memiliki kemampuan rendah dalam 

menjawabnya. Terdapat klasifikasi daya pembeda dalam menjawab soal yang diuji: 

Tabel 3.6 

Klasifikasi Daya Pembeda Soal 

Indeks Diskriminasi Klasifikasi Daya Pembeda 

0,00 – 0,20 Jelek (poor) 

0,20 – 0,40 Cukup (satisfactory) 

0,40 – 0,70 Baik (good) 

0,70 – 1,00 Baik Sekali (excellent) 

Negatif 
Semua butir soal tidak baik (lebih baik 

dibuang saja) 

Sumber: Komarudin, 2017, hlm. 179  

Berikut rumus dalam mencari daya beda soal menurut Komarudin (2017, hlm. 175) : 

D =  
BA

JA
−  

BB

JB
=  PA −  PB 

Keterangan: 

D = indeks diskriminasi 

J = jumlah peserta tes 

JA = banyaknya peserta kelompok atas 

JB = banyaknya peserta kelompok bawah 

BA = banyaknya peserta kelompok atas yang menjawab soal dengan benar 

BB = banyaknya peserta kelompok bawah yang menjawab soal dengan benar 

PA =  
BA

JA
 = proporsi peserta kelompok atas yang menjawab benar 

PA =  
BB

JB
 = proporsi peserta kelompok bawah yang menjawab benar 

Data uji taraf kesukaran dapat diolah menggunakan IBM SPSS Statistic 26 yang 

langkah-langkahnya dilakukan sebagai berikut: 

1. Buka aplikasi IBM SPSS Statistic 26. 
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2. Pada Data View, masukkan semua butir soal dan total skor benar yang didapatkan 

oleh siswa. Kode untuk jawaban yang benar adalah 1, sedangkan 0 adalah kode 

untuk jawaban yang salah. 

3. Klik Analyze -> Correlate -> Bivariate. 

4. Jendela Bivariate Correlations terbuka. Masukkan seluruh butir soal dan total ke 

dalam Variables. 

5. Pilihan Correlation Coefficients-nya adalah Pearson dengan Test of Significance-

nya adalah Two-tailed. Pastikan Flag significant correlationsnya sudah tercentang. 

6. Klik OK. 

Berdasarkan uji instrumen tes yang telah dilakukan di dua sekolah, yaitu SMK 

Kiansantang dan SMK Insan Mandiri, dengan total responden sebanyak 53 orang, didapatkan 

data hasil uji daya beda soal sebagai berikut: 

Tabel 3.7 

Hasil Uji Instrumen Uji Daya Pembeda Soal 

Nomor Item rhitung 
Indeks 

Diskriminasi 

Klasifikasi Daya 

Pembeda 

1 0,675 

Disesuaikan 

dengan tabel 

Indeks 

Diskriminasi Daya 

Pembeda Soal 

Baik 

2 0,395 Cukup 

3 0,590 Baik 

4 0,357 Cukup 

5 0,707 Baik Sekali 

6 0,315 Cukup 

7 0,680 Baik 

8 0,455 Baik 

9 0,662 Baik 

10 0,591 Baik 

11 0,357 Cukup 

12 0,694 Baik 

13 0,383 Cukup 

14 0,384 Cukup 

15 0,657 Baik 

16 0,590 Baik 

17 0,724 Baik Sekali 

18 0,719 Baik Sekali 

19 0,533 Baik 

20 0,724 Baik Sekali 

21 0,603 Baik 

22 0,526 Baik 

23 0,737 Baik Sekali 

24 0,619 Baik 
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Nomor Item rhitung 
Indeks 

Diskriminasi 

Klasifikasi Daya 

Pembeda 

25 0,625 Baik 

Sumber: Hasil pengolahan data IBM SPSS Statistic 26 

Hasil evaluasi menunjukkan bahwa seluruh nomor item dalam penelitian ini memiliki 

kualitas yang baik dan valid untuk mengukur soal pretest dan posttest. Terdapat 14 nomor item 

dengan klasifikasi "Baik", 6 nomor item dengan klasifikasi "Cukup", dan 5 nomor item dengan 

klasifikasi "Baik Sekali". 

3.2.5.5 Uji Pola Jawaban atau Distraktor 

Dari pola jawaban dalam soal, efektivitas pengecoh (distraktor) dapat diidentifikasi 

berdasarkan pemilihannya oleh peserta tes. Pengecoh yang tidak dipilih oleh peserta 

menandakan kualitas yang rendah karena terlalu mencolok dan tidak berhasil membingungkan. 

Sebaliknya, sebuah distraktor dianggap berhasil jika mampu menarik perhatian peserta tes yang 

pemahamannya terbatas, menunjukkan bahwa distraktor tersebut berperan dengan baik dalam 

tujuan penyisihan dan menguji pemahaman yang sebenarnya. Pola jawaban tersebut pada 

evaluasi pembelajaran disebut dengan omit (O) dan dapat dikatakan berfungsi baik jika paling 

sedikit dipilih oleh 5% pengikut tes (Komarudin, 2017, hlm. 181-182). 

Terdapat tiga pendekatan yang dapat diambil mengenai analisis keefektifan distraktor, 

yaitu sebagai berikut. 

1. Jika semua distraktor dalam suatu soal telah dipilih oleh sekitar 5% peserta uji, maka 

opsi diterima karena dinilai sudah mencapai standar yang baik. 

2. Jika tidak ada satupun distraktor yang dipilih oleh peserta uji (0%), maka opsi ditolak 

dikarenakan kualitas distraktor tidak memadai. 

3. Jika terdapat distraktor yang belum berfungsi secara memadai, yakni jumlah pilihan 

peserta uji yang memilihnya kurang dari 5%, maka opsi yang layak diambil adalah 

dengan merevisi kembali distraktor tersebut agar dapat lebih efektif dalam menjalankan 

peran mereka (Arikunto dalam Rahmaini & Taufiq, 2018, hlm. 17). 

Berdasarkan uji instrumen tes yang telah dilakukan di dua sekolah, yaitu SMK 

Kiansantang dan SMK Insan Mandiri, dengan total responden sebanyak 53 orang, didapatkan 

data hasil distraktor soal sebagai berikut: 
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Tabel 3.8 

Hasil Uji Distraktor Soal 

Soal 

Jawaban 

(dalam bentuk persentase (%)) Kunci Jawaban 

A B C D E 

1 21 25 6 42 8 D 

2 45 13 28 6 8 A 

3 6 36 40 8 11 C 

4 8 6 49 25 13 C 

5 9 38 21 17 15 B 

6 75 6 8 6 6 A 

7 25 9 17 13 36 E 

8 15 21 9 8 47 E 

9 23 38 13 17 9 B 

10 11 13 19 23 34 D 

11 19 8 49 8 17 C 

12 25 11 9 34 21 D 

13 77 8 6 4 6 A 

14 15 47 8 17 13 B 

15 8 6 47 8 32 C 

16 6 17 21 17 40 E 

17 8 38 9 13 32 B 

18 42 25 19 6 9 A 

19 28 23 6 36 8 D 

20 11 38 34 9 8 B 

21 17 15 11 15 42 E 

22 19 11 47 6 17 C 

23 15 6 23 36 21 D 

24 42 13 9 11 25 A 

25 34 26 13 19 8 A 

Sumber: Hasil Pengolahan data Excel 365 

Hasil data tersebut menunjukkan bahwa lima opsi jawaban atau pengecoh berfungsi 

baik karena hasil > 5%. Hanya satu opsi jawaban (D) pada soal nomor 13 yang datanya 4% < 

5%. Sehingga opsi jawaban pengecoh tersebut harus direvisi kembali. 

3.2.6 Persyaratan Analisis Data 

Aktivitas yang dilakukan pada analisis data adalah “… mengelompokkan data 

berdasarkan variabel dan jenis responden, mentabulasi data berdasarkan variabel dari seluruh 

responden, menyajikan data tiap variabel yang diteliti, melakukan perhitungan untuk 

menjawab rumusan masalah, dan melakukan perhitungan untuk menguji hipotesis yang telah 

diajukan” (Sugiyono, 2015, hlm. 147). 
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Penulis melakukan analisis statistik parametrik yang terdiri dari beberapa teknik uji 

yang digunakan untuk menentukan efektivitas suatu model pembelajaran. Teknik-teknik 

tersebut antara lain Uji t, Uji F, dan Uji Post-Hoc. Uji t digunakan khususnya untuk menguji 

pengaruh model pembelajaran terhadap variabel atau aspek tertentu. Sebelum melakukan Uji 

t, penting untuk memeriksa apakah data yang akan diuji berdistribusi normal dan homogen. 

3.2.6.1 Uji Normalitas 

Sebelum melakukan pengujian, penting untuk memeriksa apakah data yang akan diuji 

berdistribusi normal atau tidak. Untuk menguji normalitas data, digunakan uji Kolmogorov 

Smirnov dengan bantuan program statistik IBM SPSS Statistic 26. Jika hasil uji menunjukkan 

nilai signifikansi lebih dari 0,05 maka data dianggap berdistribusi normal. Berikut cara 

mengolah data uji normalitas di IBM SPSS Statistic 26: 

1. Buka aplikasi IBM SPSS Statistic 26. 

2. Pada Variable View, tulis pretest dan posttest dengan mengubah Decimals menjadi 

0 dan menambahkan label sesuai jenis tesnya. Pilihan untuk kedua Measure jenis 

tes tersebut adalah Scale. 

3. Pada Data View, masukkan skor pretest dan posttest. 

4. Klik Analyze -> Nonparametric Tests -> Legacy Dialogs -> 1-Sample KS. 

5. Jendela One-Sample Kolmogorov-Smirnov Test sudah terbuka. Masukkan 

variabel skor pretest dan posttest ke dalam Test Variable List. Kemudian pastikan 

Test Distribution sudah Normal sudah tercentang. 

6. Klik OK. 

3.2.6.2 Uji Homogenitas 

Apabila sampel yang diambil dari populasi yang sama memiliki keseragaman dan 

varians yang tidak terlalu berbeda antara satu sampel dengan yang lainnya, maka dapat 

dikatakan bahwa sampel-sampel tersebut cukup homogen. Dalam penelitian ini, untuk menguji 

homogenitas skor hasil pre-test dan post-test, digunakan uji ANOVA (Analysis of Variance) 

dengan bantuan program statistik IBM SPSS Statistic 26. Kriteria yang digunakan adalah jika 

nilai signifikansi lebih besar dari 0,05, maka varian data dua atau lebih dianggap sama atau 

homogen. Namun, jika nilai signifikansi kurang dari 0,05 maka varian data dua atau lebih 

dianggap tidak sama atau tidak homogen. Berikut cara mengolah data uji homogenitas 

menggunakan aplikasi IBM SPSS Statistic 26: 

1. Buka aplikasi IBMS SPSS Statistic 26. 
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2. Pada Variable View, tulis Skor_Siswa di baris 1 dengan Decimals 0 dan Measure 

menjadi Scale. 

3. Pada baris 2, tulis Jenis_Tes dengan Decimals 0, kemudian kolom Values klik titik 

tiga disampingnya sehingga jendela Value Labels muncul. Isi Value dengan angka 

1 untuk Label pretest dan angka 2 untuk Label posttest, lalu klik OK. Setelah itu 

pada kolom Measure pilih Nominal. 

4. Klik Data View, masukkan gabungan skor pretest dan posttest pada kolom 

Skor_Siswa. Pada kolom Jenis_Tes masukkan kode nomor 1 untuk nilai pretest 

dan kode nomor 2 untuk nilai posttest. 

5. Klik Analyze -> Compare Means -> One-Way ANOVA -> masukkan variabel 

Skor_Siswa ke Dependent List -> masukkan variabel Jenis_Tes ke Factor. 

6. Klik Post Hoc -> centang Bonferroni dan Tukey -> Continue. 

7. Klik Options -> centang Descriptive dan Homogeneity of variance test -> 

Continue. 

8. Klik OK. 

3.2.7 Teknik Analisis Data 

Setelah memenuhi persyaratan analisis data, langkah selanjutnya adalah menguji hasil 

pretest dan posttest. Tujuan dari pengujian ini adalah untuk mengetahui adanya perbedaan hasil 

belajar sebelum dan setelah diberikan perlakuan model pembelajaran. 

3.2.7.1 Uji N-Gain 

Uji N-Gain adalah sebuah metode statistik yang digunakan untuk memberikan 

gambaran tentang sejauh mana peningkatan hasil belajar siswa dari pretest ke posttest sebelum 

dan setelah penerapan model pembelajaran. Metode ini mengukur besarnya perubahan skor 

siswa dari kondisi awal (pretest) ke kondisi akhir (posttest) sebagai indikator peningkatan 

kemampuan belajar (Fauzi et al., 2022, hlm. 46). Berikut adalah rumus N-Gain: 

N Gain =  
Mean skor posttest − mean skor pretest

nilai ideal (100) − mean skor pretest
 

Data uji N-Gain dapat diolah pada IBM SPSS Statisctic 26. Berikut adalah langkah-

langkah dalam mengolah datanya: 

1. Buka aplikasi IBM SPSS Statistic 26. 

2. Masukkan skor siswa ke variabel pretest dan variabel posttest. 

3. Klik Transform -> Compute Variable. 

4. Jendela Compute Variable terbuka. Pada Target Variable tulis NGain. 
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5. Pada Numeric Expression masukkan rumus N-Gain. Klik OK. 

6. Hasilnya akan terlihat di jendela Data View. 

7. Kemudian untuk melihat deskripsinya, klik Analyze -> Descriptive Statistic -> 

Descriptivies -> jendela Descriptive terbuka -> pindahkan variabel NGain ke 

Variable(s): 

8. Klik OK. 

Rentang peningkatan hasil pretest dan posttest dapat dilihat pada tabel klasifikasi 

berikut ini: 

Tabel 3.9 

Klasifikasi Skor N-Gain 

Skor N-Gain Klasifikasi 

N-Gain > 0,7 Tinggi 

0,3 ≤ N-Gain ≤ 0,7 Sedang 

N-Gain < 0,3 Rendah 

Sumber: Fauzi et al., 2022, hlm. 46 

3.2.8 Pengujian Hipotesis 

3.2.8.1 Uji Paired Samples T-Test 

Teknik analisis yang digunakan pada penelitian ini dalam menguji hipotesis adalah 

dengan Uji t berpasangan. Uji t berpasangan memiliki tujuan untuk mendapatkan perbedaan 

hasil belajar pada mata pelajaran OTK Keuangan di materi Kas Kecil dalam Perusahaan dengan 

model pembelajaran Advance Organizer. Hasil belajar dinilai dari pre-test dan post-test.  Untuk 

mengujinya dibantu dengan program IBM SPSS Statistic 26 dengan taraf signifikan 0,05. 

Kriterianya adalah jika 𝑡ℎ𝑖𝑡𝑢𝑛𝑔 ≥  𝑡𝑡𝑎𝑏𝑒𝑙 maka H0 ditolak dan 𝑡ℎ𝑖𝑡𝑢𝑛𝑔 ≤ 𝑡𝑡𝑎𝑏𝑒𝑙 maka Ha 

diterima. 

Berikut langkah-langkah mengolah data uji paired sample t-test. 

1. Buka aplikasi IBM SPSS Statistic 26. 

2. Masukkan skor pretest dan posttest. 

3. Klik Analyze -> Compare Means -> Paired-Samples T Test -> masukkan variabel 

pretest ke Variable1 dan variabel posttest ke Variable2. 

4. Klik Options -> Confidence Interval Percentage-nya adalah 95% -> Continue. 

5. Klik OK. 
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3.2.8.2 Uji Effect Size 

Selanjutnya untuk melihat keefektifan model pembelajaran Advance Organizer, maka 

langkah selanjutnya adalah menguji effect size. “Uji effect size merupakan sebuah metode uji 

statistik yang digunakan untuk mengetahui besar keefektifan dari model pembelajaran, istilah 

lainnya bisa diartikan sebagai langkah untuk mengukur seberapa besar skala keefektifan model 

pembelajaran yang sudah diterapkan pada sebuah penelitian” (Lakens dalam Fauzi et al., 2022, 

hlm. 46). Pengukuran efektifitas dapat dilakukan dengan menggunakan rumus Cohen D 

sebagai berikut: 

𝑑 =  
𝑥̅𝑡 −  𝑥̅𝑐

𝑠𝑝𝑜𝑜𝑙𝑒𝑑
 

dengan 

𝑆𝑝𝑜𝑜𝑙𝑒𝑑 =  √
(𝑛𝑡 − 1)𝑠𝑡

2 + (𝑛𝑐 − 1)𝑠𝑐
2

𝑛𝑡 + 𝑛𝑐
 

Keterangan: 

d = effect size Cohen 

𝑥̅ = mean 

st = standar deviasi posttest 

sc = standar deviasi pretest 

n = jumlah sampel 

Data effect size dapat diolah pada IBM SPSS Statisctic 26. Berikut adalah langkah-

langkah dalam mengolah datanya: 

1. Buka aplikasi IBM SPSS Statistic 26. 

2. Pada Variable View, masukkan data Mean_Post, Mean_Pre dan Std_Post dengan 

Measurenya menjadi Scale. 

3. Pada Data View, masukkan skor rata-rata posttest pada variabel Mean_Post, masukkan 

skor rata-rata pretest pada variabel Mean_Pre, dan skor standar deviasi posttest pada 

variabel Std_Post. 

4. Klik Transform -> Compute Variable. 

5. Jendela Compute Variable sudah terbuka. Isi Target Variable dengan Effect_Size. 

6. Masukkan rumus Cohen’s D ke dalam Numeric Expression. 

7. Klik OK. Hasilnya akan terlihat pada Data View. 

Kemudian untuk melihat klasifikasi skor uji effect size adalah sebagai berikut: 
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Tabel 3.10 

Klasifikasi Effect Size 

Skor Klasifikasi Effect Size 

0,00 – 0,20 Efek sangat lemah 

0,21 – 0,50 Efek lemah 

0,51 – 1,00 Efek sedang 

> 1,00 Efek kuat 

Sumber: Fauzi et al., 2022, hlm. 47 

3.2.9 Prosedur Penelitian 

Berikut adalah tahap-tahap prosedur dalam penelitian kepada kelas XII OTKP di SMK 

Pasundan 1 Cimahi pada mata pelajaran Otomatisasi Tata Kelola Keuangan materi Dana Kas 

Kecil dalam Perusahaan menggunakan model pembelajaran Advance Organizer: 

1. Tahap Persiapan 

Pada tahap ini, langkah-langkah yang diperlukan untuk mempersiapkan penelitian 

adalah sebagai berikut: 

a. Mempelajari secara mendalam materi pelajaran Bab 1 Dana Kas Kecil dalam 

Perusahaan untuk kelas XII OTKP di SMK Pasundan 1 Cimahi. 

b. Berkonsultasi dengan dosen pembimbing serta pihak sekolah guna membahas 

rencana teknis pelaksanaan penelitian. 

c. Menyusun rencana pembelajaran yang detail, termasuk Rencana Pelaksanaan 

Pembelajaran (RPP) yang sesuai dengan materi dan penerapan model 

pembelajaran Advance Organizer. 

d. Menyiapkan instrumen penelitian yang akan digunakan. 

2. Tahap Pelaksanaan 

a. Pra Pelaksanaan 

1) Memberikan penjelasan komprehensif kepada siswa kelas XII OTKP di 

SMK Pasundan 1 Cimahi mengenai tujuan dan metode penelitian yang 

akan dilakukan. 

2) Melakukan pretest menggunakan instrumen tes untuk mengukur 

pemahaman awal siswa sebelum menerapkan model pembelajaran 

Advance Organizer. 

b. Pelaksanaan Perlakuan 

1) Menerapkan model pembelajaran Advance Organizer kepada siswa. 
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2) Melaksanakan proses pembelajaran dengan memberikan materi 

mengenai Dana Kas Kecil dalam Perusahaan. 

c. Pasca Perlakuan 

Melakukan posttest untuk mengukur pemahaman siswa setelah penerapan 

model pembelajaran Advance Organizer. 

3. Tahap Akhir 

Pada tahap ini, langkah-langkah yang perlu diambil adalah sebagai berikut: 

a. Menganalisis data yang telah dikumpulkan selama tahap pelaksanaan dan 

menggunakan metode uji yang sesuai. 

b. Merumuskan kesimpulan berdasarkan hasil analisis data dan mencari pola atau 

temuan yang signifikan. 

3.2.10 Aktivitas Pembelajaran Model Advance Organizer 

Pada proses pembelajaran di kelas, diperlukan langkah-langkah dari model 

pembelajaran yang diterapkan. Secara umum, berikut aktivitas yang dilakukan selama belajar 

dan mengajar di kelas menggunakan model pembelajaran Advance Organizer: 

1. Fase 1: Penyajian Advance Organizer 

Guru menjabarkan gagasan dan tujuan pembelajaran kepada siswa. Supaya 

siswa dapat terjaga perhatiannya, guru mengklarifikasi tujuan dari materi yang akan 

dipelajari dengan cara merangsang pengetahuan yang telah dimiliki siswa sebelumnya. 

Caranya ialah guru memberikan contoh-contoh yang familiar dengan pengalaman 

siswa. 

Pada tahap ini guru dan siswa sama-sama mengeksplorasi pengetahuan yang 

sudah ada dan memberikan informasi mengenai konsep-konsep materi yang terkait. 

Guru dan siswa terus mengulang tahap ini sampai siswa memahami materi bahkan bisa 

menggunakan terminologi sendiri. 

2. Fase 2: Penyajian Tugas Pembelajaran atau Materi 

Pada tahap ini, pembelajaran dilakukan dengan diskusi, membaca, atau 

eksperimen. Guru membuat urutan materi secara jelas dan logis sehingga siswa dapat 

mengetahui tujuan dari materi yang dipelajari secara keseluruhan. 

3. Fase 3: Memperkuat Pengaturan Kognitif 

Guru membantu struktur kognitif siswa lebih kuat pada tahap ini. Guru 

membantu siswa yang belum mengerti materi. Cara-cara yang dilakukan adalah: 

a) guru merangkum kembali gagasan materi yang telah dipelajari, 
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b) mengklarifikasi beberapa definisi dan membuat perbedaan antara beberapa aspek, 

c) siswa diminta secara lisan untuk mengungkapkan konsep-konsep yang telah 

dipelajari menggunakan terminologi dan kerangka berpikirnya sendiri, 

d) guru dapat menguji siswa untuk menjawab pertanyaan sesuai sudut pandang siswa, 

e) siswa dapat mengenali hipotesis dari materi yang telah dipelajari (Joyce et al., 2016, 

hlm. 332-335). 

Materi pelajaran yang dibawakan dalam penelitian ini adalah Kas Kecil dalam 

Perusahaan dengan Kompetensi Inti, Kompetensi Dasar, dan Indikator Pencapaian Kompetensi 

yang dijabarkan berikut ini: 

1. Kompetensi Inti 

3. Memahami, menerapkan, menganalisis dan mengevaluasi tentang pengetahuan 

faktual, konseptual, operasional dasar, dan metakognitif sesuai dengan bidang dan 

lingkup kerja Otomatisasi dan Tata Kelola Perkantoran pada tingkat teknis, spesifik, 

detail, dan kompleks, berkenaan dengan ilmu pengetahuan, teknlogi, seni, budaya, dan 

humaniora dalam konteks pengembangan potensi diri sebagai bagian dari keluarga, 

sekolah, dunia kerja, warga masyarakat nasional, regional, dan internasional. 

4. Melaksanakan tugas spesifik dengan menggunakan alat, informasi, dan prosedur 

kerja yang lazim dilakukan serta memecahkan masalah seseuai dengan bidang kerja 

Otomatsasi dan Tata Kelola Perkantoran. Menampilkan kinerja di bawah bimbingan 

dengan mutu dan kuantitas yang terukur sesuai dengan standar kompetensi kerja. 

Menunjukkan keterampilan menalar, mengolah, dan menyaji secara efektif, kreatif, 

produktif, kritis, mandiri, kolaboratif, komunikatif, dan solutif dalam ranah abstrak 

terkait dengan pengembangan dari yang dipelajarinya di sekolah, serta mampu 

melaksanakan tugas spesifik di bawah pengawasan langsung. Menunjukkan 

keterampilan mempersepsi, kesiapan, meniru, membiasakan, gerak mahir, menjadikan 

gerak alami dalam ranah konkret terkait dengan pengembangan dari yang dipelajarinya 

di sekolah, serta mampu melaksanakan tugas spesifik di bawah pengawasan langsung. 

2. Kompetensi Dasar 

3.10 Memahami ruang lingkup dana kas kecil 

4.10  Mengelompokkan ruang lingkup dana kas kecil 

3. Indikator Pencapaian Kompetensi 

3.10.1 Menjelaskan pengertian dana kas kecil 

3.10.2 Menjelaskan tujuan dibentuknya dana kas kecil 

4.10.1 Melakukan identifikasi ruang lingkup dana kas kecil 
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4.10.2 Melakukan pengelompokkan ruang lingkup dana kas kecil 

Kemudian untuk pendekatan yang digunakan adalah comparative organizer. 

Comparative organizer menunjukkan persamaan dan perbedaan antara pengetahuan siswa 

sebelumnya dan konten baru yang akan disajikan. Pengaturannya mencakup penggunaan 

tampilan visual dan grafis yang menggambarkan hubungan antara fakta, istilah, dan ide dalam 

tugas pembelajaran (Anaeche, 2022, hlm. 38). Berikut ini adalah tahapan-tahapan yang 

dilakukan dalam pendekatan comparative organizer. 

Tabel 3.11 

Tahapan Comparative Organizer 

Tahapan Keterangan 

Identifikasi Pengetahuan Awal Penulis akan mengidentifikasi pengetahuan 

sebelumnya yang sudah dimiliki oleh siswa 

tentang materi yang akan diajarkan, yaitu 

mengenai ruang lingkup kas kecil, 

karakteristik dan komposisi kas kecil, serta 

dokumen dana kas kecil. Penulis perlu 

mengetahui apa yang sudah dikenal oleh 

siswa sebelum memperkenalkan materi baru. 

Identifikasi Materi Baru Penulis kemudian memperkenalkan materi 

baru yang akan diajarkan, seperti aspek-

aspek baru dalam ruang lingkup kas kecil, 

karakteristik dan komposisi, serta jenis 

dokumen dana kas kecil. Materi baru ini akan 

menjadi fokus perbandingan dengan 

pengetahuan sebelumnya. 

Pembandingan Pengetahuan Lama dan 

Baru 

Tahap ini melibatkan perbandingan antara 

apa yang telah diketahui siswa sebelumnya 

dengan materi baru yang diajarkan. Penulis 

menggunakan tampilan visual dan grafis 

untuk memperlihatkan persamaan dan 

perbedaan antara pengetahuan lama dan 

baru. Ini membantu siswa memahami 

bagaimana informasi baru ini terhubung 
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dengan yang sudah mereka ketahui 

sebelumnya. 

Integrasi Materi Baru dengan 

Pengetahuan Lama 

Penulis mengajarkan bagaimana konsep baru 

ini berkaitan dengan konsep yang sudah 

dikenal sebelumnya. Ini membantu siswa 

melihat kesinambungan antara pengetahuan 

yang ada dengan informasi baru yang 

diperoleh. 

Pengidentifikasian Relevansi dan 

Keterkaitan 

Siswa diminta untuk memahami relevansi 

konsep baru dengan konteks yang lebih luas. 

Mereka mempertimbangkan apakah ide-ide 

baru tersebut relevan dalam konteks ruang 

lingkup kas kecil dan bagaimana hal tersebut 

dapat digunakan dalam situasi nyata. 

Pengingatan dan Penyimpanan Tahap ini mencakup penyampaian konsep 

baru dalam bentuk yang mudah diingat dan 

dipahami oleh siswa. Tampilan visual dan 

grafis seperti tayangan PowerPoint (PPT) 

yang digunakan membantu mengingatkan 

siswa akan hubungan antara konsep-konsep 

tersebut. 

Pengkajian Konsep Siswa diberi kesempatan untuk 

merefleksikan dan mengkaji konsep-konsep 

yang baru mereka pelajari. Mereka dapat 

berdiskusi, bertanya, dan mengajukan 

pertanyaan mengenai bagaimana konsep 

baru ini berhubungan dengan pengetahuan 

mereka sebelumnya. 

 

  



65 
 

Sifa Kamelia, 2023 
Pengaruh Model Pembelajaran Advance Organizer terhadap Hasil Belajar Siswa 
Universitas Pendidikan Indonesia I repository.upi.edu I perpustakaan.upi.edu 

Sehingga berdasarkan penjabaran dari pendekatan yang dipilih dalam pembelajaran 

tersebut, maka secara umum langkah pembelajarannya adalah sebagai berikut. 

Tabel 3.12 

Langkah Pembelajaran Advance Organizer 

Pretest 

Pertemuan 1 Fase 1: Penyajian Advance Organizer 

- Guru memberikan pemahaman dan tujuan kepada peserta didik 

mengenai ruang lingkup kas kecil meliputi pengertian dari para 

ahli, tujuan dan fungsi dilakukannya dana kas kecil. 

- Guru bertanya kepada peserta didik mengenai pengelolaan 

keuangan apa saja yang sudah familiar dengan peserta didik dengan 

materi ruang lingkup kas kecil dimulai dari lingkungan biasa 

hingga ke perusahaan. 

 

Fase 2: Penyajian Tugas Pembelajaran atau Materi 

- Guru menyajikan terlebih dahulu mengenai materi ruang lingkup 

kas kecil. 

- Peserta didik memperhatikan contoh-contoh materi yang 

dijelaskan oleh guru. 

- Peserta didik bertanya mengenai materi yang telah dijelaskan. 

- Peserta didik mengidentifikasi fungsi dan tujuan dilakukannya 

dana kas kecil. 

Fase 3: Memperkuat Pengaturan Kognitif 

- Peserta didik mengulang kembali hasil diskusi mengenai materi 

yang telah dipelajari. 

- Peserta didik mengisi lembar kerja yang telah disediakan guru atau 

menggunakan buku tulis miliknya. 

- Peserta didik menandai hal-hal penting yang akan disampaikan 

pada saat berdiskusi baik dengan temannya atau guru. 

- Peserta didik mempresentasikan hasil diskusinya berupa 

pengaplikasian konsep dengan menggunakan contoh-contoh baru 

dari materi yang telah dipelajari. 

- Guru memperkuat,  mengklarifikasi materi dan  mengulang 

kembali konsep-konsep yang berkaitan dengan materi ini. 

 

Pertemuan 2 Fase 1: Penyajian Advance Organizer 

- Guru memberikan pemahaman kepada peserta didik mengenai 

pentingnya memahami karakteristik dan komposisi dari kas kecil. 

- Guru bertanya kepada peserta didik mengenai peralatan 

penyimpanan keuangan apa saja yang sudah familiar dengan 

peserta didik dengan materi karakteristik kas kecil dimulai dari 

lingkungan biasa hingga ke perusahaan. 
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- Guru bertanya mengenai manfaat dana kas kecil bagi sebuah 

perusahaan kepada peserta didik. 

Fase 2: Penyajian Tugas Pembelajaran atau Materi 

- Guru menyajikan terlebih dahulu mengenai materi karakteristik 

dasar kas kecil dan komposisi kas kecil. 

- Peserta didik memperhatikan contoh-contoh materi yang 

dijelaskan oleh guru. 

- Guru memberikan penyajian mengenai bukti penggunaan kas kecil. 

- Guru memberikan tugas mengenai alur dalam pencatatan bukti 

penggunaan kas kecil. 

- Peserta didik bertanya dan berdiskusi mengenai materi yang telah 

dijelaskan. 

- Peserta didik mengerjakan tugas mengenai alur dalam pencatatan 

bukti penggunaan kas kecil. 

- Peserta didik mengidentifikasi pengelolaan bukti penggunaan kas 

kecil serta komposisi kas kecil pada alur tersebut. 

Fase 3: Memperkuat Pengaturan Kognitif 

- Peserta didik mengulang kembali hasil diskusi mengenai materi 

yang telah dipelajari. 

- Peserta didik mengisi lembar kerja yang telah disediakan guru atau 

menggunakan buku tulis miliknya. 

- Peserta didik menandai hal-hal penting yang akan disampaikan 

pada saat berdiskusi baik dengan temannya atau guru. 

- Peserta didik mempresentasikan hasil diskusinya berupa 

pengaplikasian konsep dengan menggunakan contoh-contoh baru 

dari materi yang telah dipelajari. 

- Guru memperkuat, mengklarifikasi materi dan  mengulang kembali 

konsep-konsep yang berkaitan dengan materi ini. 

 

Pertemuan 3 Fase 1: Penyajian Advance Organizer 

- Guru memberikan pemahaman kepada peserta didik tentang 

pentingnya dokumen dana kas kecil. 

- Guru bertanya kepada siswa mengenai bukti atau dokumen dana 

kas kecil apa saja yang sudah familiar dengan siswa berkaitan 

materi dokumen dana kas kecil. 

Fase 2: Penyajian Tugas Pembelajaran atau Materi 

- Guru menyajikan terlebih dahulu mengenai materi dokumen dana 

kas kecil. 

- Peserta didik memperhatikan contoh-contoh materi yang 

dijelaskan oleh guru, seperti receipt, invoice, cek, dan bilyet giro. 

- Peserta didik bertanya mengenai materi yang telah dijelaskan. 
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- Guru memberikan tugas mengenai bukti transaksi meliputi bukti 

pengeluaran intern dan ekstern dalam perusahaan. 

- Peserta didik mengidentifikasi bukti pemakaian kas kecil dalam 

perusahaan. 

Fase 3: Memperkuat Pengaturan Kognitif 

- Peserta didik mengulang kembali hasil diskusi mengenai materi 

yang telah dipelajari. 

- Peserta didik mengisi lembar kerja yang telah disediakan guru atau 

menggunakan buku tulis miliknya. 

- Peserta didik menandai hal-hal penting yang akan disampaikan 

pada saat berdiskusi baik dengan temannya atau guru. 

- Peserta didik mempresentasikan hasil diskusinya berupa 

pengaplikasian konsep dengan menggunakan contoh-contoh baru 

dari materi yang telah dipelajari. 

- Guru memperkuat, mengklarifikasi materi dan  mengulang kembali 

konsep-konsep yang berkaitan dengan materi ini. 

Posttest 

 

  


